USB TO RS-232 ADAPTER

User’s Manual

UMC-100/ UMC-101/ UMC-102 /UMC-104
UMC-201/UMC-201RL / UTS-232TB / UPR-202
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Introduction

Universal Serial Bus (USB) port technology has emerged in response to the proliferation of external
peripheral devices (scanner, digital camera, portable hard-disk drive, cell phone, PDA, MP3 player,
etc.) that are increasingly being connected to the latest generation of PCs. The USB behaves in a
similar fashion to conventional bus ports like Serial (COM), Parallel and PS/2. As it doesn’t require
any IRQs, more devices can be attached to the system without conflicts.

This USB to Serial converter provides an external plug-and-play connection for RS-232 enabled
devices with PC or any computerizing devices that support the USB specification. The converter
comes with the standard connectors of Serial DB-25 or DB-9 and USB Type A or B to fulfill your
working requirements. With the link of USB to Serial cable, communication starts interacting
without any barriers.

For further convenience, this product is designed to work by using the power drawn from the
Universal Serial Bus and no external power is required. As itis an USB compliant device, features
of plug and play, hot-swapping, energy-saving suspend, and resume are provided.

Since the most computers have limited USB and COM ports, USB hubs can be employed to gain
more USB ports for numerous USB peripheral devices to be connected up with your PC at the time.

System Requirements

Windows : 98 / ME / 2000 / XP / Vista /7 / 8 / 2003 / 2008 / 2008R2
WinCE :V4.2~V7.0

Mac OS :8.x/9.x/10.x

Linux : Kernel 1.5.0 or above

The system is equipped with USB Host Controller

VVVVYY

Features

Achieving RS-232 interfaced devices communicate with your PC through USB port
Each port can be independently configured into various synchronous and asynchronous
interfaces

Supports default ROM or external EEPROM for device configuration

Supports plug & play and hot-swapping

Over 1Mbps transfer rate per port

VVV VYV
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Specification

Model No. UMC-100 | UMC-101 [ UMC-201 | UMC-201RL | UTS-232TB | UMC-102 | UMC-104
Chipset FTDI
Compliant Version USB1.1&2.0
Data USB 15/ 1.2 Mbps
Speed Serial 230K bps

Host USB B/F USB A/M USB BIF
Connector | oyice | pB-25/M*1 | PB25 + DB-9/M Terminal | 1o o/ | DB-9/M*4

9/M Block

Power Mode Bus
Cable Length 1.8M | 0.4M 1M | 0.6M 1.8M
Housing Plastic PVC | Plastic Aluminum

Please Note for Model UMC-101: Device on DB-25 and DB-9 can not be operated at the
same time.
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RS 232 Pin Assignment

DB-9

TERMINAL BLOCK

UMC-101/102/104 /201 / 201RL UTS-232TB

Pin No.| Definition Description 5 4 3 2 1
1 DCD Data Carrier Detected G CTS| Rx RTS Tx
2 RxD Receive Data
3 TxD Transmit Data Pin No.| Definition Description
4 DTR Data Terminal Ready 1 TxD Transmit Data
5 GND Signal Ground 2 RTS Request To Sent
6 DSR Data Set Ready 3 RxD Receive Data
7 RTS Request To Sent 4 CTS Clear To Sent
8 CTS Clear To Sent 5 G Signal Ground
9 RI Ring Indicator

UMC-100
Pin No.| Definition Description
2 TxD Transmit Data
3 RxD Receive Data
4 RTS Request To Sent
5 CTS Clear To Sent
6 DSR Data Set Ready
7 GND Signal Ground
8 DCD Data Carrier Detected
20 DTR Data Terminal Ready
22 RI Ring Indicator
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Windows 98 Installation Guide

If a device of the same type has been installed on your machine before and the drivers
that are about to be installed are different from those installed already, the original
drivers need to be uninstalled. Please refer to the uninstalling instruction.

Download the latest available drivers from the FTDI website and unzip them to a
location on your PC.

Connect the device to a spare USB port on your PC. This will launch the
Windows Add New Hardware Wizard. Windows may display a message reading
"Building driver database" at this point which may take a few minutes to pass.
Click "Next" to proceed with the installation.

Add New Hardware Wizard

Thiz wizard zearches fol new drivers for:

I15B <-» Senal Cable

& device driver iz a software program that makes a
hardware device work.

Cancel |

¢ Back

Select "Search for the best driver for your device. (Recommended)." as shown below
and then click "Next".
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Add New Hardware Wizard I

Wwhhat do vou want WwWindows to do?

& Search for the best driver for your device,
[Recammended).

™ Dizplay a lizt of all the drivers in a spectic
lnzation, 20 yau can select the driver vou want,

< Back I MNext = I Cancel

- Check the box next to "Specify a location" and uncheck all others as shown below.
Click "Browse" and locate the driver files. Once the files have been located, click
"Next" to proceed with the installation.

Add New Hardware Wizard I

‘wiindows will search for new drivers in its diver database
on pour hard drive, and in any of the following selected
lozations. Click Mest to start the search.

™ Foppy dizk drives
[T CO-ROM drive
™ Microsoft Windows Update

W Specify a location;
D =]
Browse... |

< Back I MNext = I Cancel |

Windows may display a message reading "Building driver database" at this point
which may take a few minutes to pass. Once Windows has found the required
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files, click "Next" to install the device.

Add New Hardware Wizard

“afincows driver file seanch for the device;

[15B Serial Converter

‘Windows iz now ready o install the best dover for this
device. Click Back to select a different driver, ar click Mewxt
bo continue,

Location of driver:

CAMCPDRITTMTDIBUS.INF
=

¢ Back

Cancel |

If the driver being installed does not have Microsoft WHQL signature files (.CAT files),
the wizard will request a driver disk to attempt to find them. Click "OK" on the "Insert
Disk" message box.

Inzert Dizk EZ

0 Pleaze insart the diz< labeled 'FT DI USE Drivers Digk', and then click OFK.

The following window will appear to assist in locating the file. To proceed with the
installation without the .CAT file, click "Skip File".
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Inzert Digk
The file 'ftdibug.cat on FTDN USE Drivers 0k
‘ﬁ Dizk cannat be found.

Cancel

[nzert FTDI USE Drivers Digk in the selected
drive, and click OF.

Skip File

Details...

vI Browze. .

LCooy files from;

PEE ELR

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be
located with the other driver files and should be installed automatically.

Windows should then display a message indicating that the installation of the
serial converter driver was successful. The COM port emulation driver must now
be installed. Click "Finish" to complete the installation of the serial converter and
proceed to the COM port emulation driver.

Add New Hardware Wizard

% [ISE Seral Converter

Windows has finished installing the software that vour new
hardware device requires.

¢ Back

Cancel |

Under Windows 98, the COM port emulation driver will be automatically installed from
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the same location as the serial converter driver. However, if the driver is not WHQL
certified as explained above for the serial converter driver, the wizard will ask for the
location of .CAT files. Click "OK" on the "Insert Disk" message box.

Insert Disk |

Q Fleaze inzert the dis< labeled 'FTOI LISB Drivers Disk', and then click OF.

The following window will appear to assist in locating the file. To proceed with the
installation without the .CAT file, click "Skip File".

Inzert Disk
The file 'ftdiport.cat on FTD| USE Drivers 0k
é‘ Dizk cannaot be found.

Cancel
|nzert FTDI USE Drivers Digk in the zelected
drive, and click OF.

Skip File

Detailz...

LCoow files fromm:

PEE RN

CAYEP Dirivers j Browsze. .

If the driver being installed is Microsoft WHQL certified, then the .CAT files will be
located with the other driver files and should be installed automatically.
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Open the Device Manager (located in "Control Panel\System" then select the "'Device
Manger" tab) and select "View devices by type". The device appears as an additional
COM port with the label "USB Serial Port".

System Properties E1 |

General Device Manager |Hardware F'rn:nfilesl F‘erfn:nrmann:el

% Yiew devices by bype ™ Wiew devices by connection

E33 #2 Keyboard il

-l Modem
-l b omikors
57y Mouse

\> kultilDController
8@ Network adapters

Portz [COM & LPT)
'_}yf Cammunications Part [CORT]
. PCIECPYEPP Port [LPT1)

ﬁ__bgf PCl Serial Pait [COM2)

182 Universal Serial Buz controllers
- Univerzal Serial Bus controllers =
Properties | Refresh | Remove | Print... |

Ik I Fanrel I

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.
you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for
4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download
the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

To uninstall drivers, follow the instructions below:

Disconnect any devices that are attached to the PC.

Open the Add/Remove Programs utility located in "Control Panel\Add/Remove

Programs". Select "FTDI USB-Serial Converter Drivers" from the list of installed
programs.

Add/Bemove Programs Properhes I

Install /U hitstall | windowes Setip I Startup Disk I

% Ta nztall a new program fram a floppy disk or CO-ROM
g

drive, chok Inztall,
Install...

{7% The fallowing zoftware can be automaticall removed by
Al

YWirdowsz, Tao remove a program or to madily its installed
components, zelect it from the lizt and click
Add‘Remove.

Traditional] Language Supy
(ETDN LSB-to-Senal Corveerter Drivers
GetRight

[ngtantCODVD J
|nternet Explarer Q328750

Japaneze Language Suppart

FemelDriver

Key Drive 1.0
K.orean Language Support j

Sdd/Bemove. .. |

ok | Camesl | Appl |

Click the "Add/Remove" button. This will run the FTDI uninstaller program. Click
"Continue" to run the uninstaller or "Cancel" to exit.
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FTDI Uninstaller ¥3.0

When the uninstaller has finished removing the device from the system, the caption on
the "Cancel" button will change to "Finish". Click "Finish" to complete the process.

FTDI Uninstaller ¥3.0

gt | =
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Troubleshooting

1. Windows 98 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not
match those listed in the INF files for the driver. The VID and PID programmed into the
device EEPROM may be found by using the USBView utility from the FTDI website.
These can then be checked against the VID and PID entries in the driver INF files. If
they do not match, that driver cannot be installed the VID and PID entries in the driver
INF files. If they do not match, that driver cannot be installed for that device without
either re-programming the device EEPROM or modifying the list of VID and PID
numbers in the INF files. Please note that only your own company VID and PID or
FTDI's VID (0x0403) and FTDI PID issued for use by your company should be used in
the EEPROM and INF/INI files.

2. Windows 98 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware
Wizard is trying to copy it. This usually occurs with the FTD2XX.DLL file. If installing a
D2XX device, selecting not to restart the computer then unplugging and re-plugging the
device may allow the device to function properly without restarting. Restarting the
machine will allow the device to work correctly.

3. Driver installation fails and Windows 98 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error
may appear if a device has insufficient power to operate correctly (e.g. plugged into a
bus powered hub with other devices), or may indicate a more serious hardware problem.
Also, it may be indicative of USB root hub drivers being incorrectly installed. Please refer
to the example schematics on the FTDI website for standard device configurations. If
the error persists, please contact the FTDI support department.

4. Device hangs randomly during operation under Windows 98

This is not caused by the driver, but is a hardware compatibility problem. Some newer
USB 2.0 hubs and host controllers can be susceptible to noise and can cause random
device failures. This can be overcome by fitting 47pF capacitors to ground on the
USBDP and USBDM lines on the USB connector side of the 27W series resistors.

5. Windows 98 complains about missing .CAT files

Files with the .cat extension are signature files issued by Microsoft that indicate a device
driver is WHQL certified. If a driver is not certified, there will be no .cat files available.
When installing drivers in Windows 98 or Windows ME, the user is prompted to locate
the .cat files if the operating system cannot find them. If the driver is not certified but you
wish to install it anyway, the files may be skipped by clicking the "Skip" button.
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6. Windows 98 complains about missing ftccomms.vxd file

This can occur when the USB Composite driver has been installed if the user has not
browsed to the location of the driver files. If this message appears, do not skip it but
browse to the driver file location. The wizard will then be able to correctly install the
device.
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Windows 2000 Installation Guide

If a device of the same type has been installed on your machine before and the
drivers that are about to be installed are different from those installed already, the
original drivers need to be uninstalled. Please refer to the uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a
location on your PC.

Connect the device to a spare USB port on your PC. Once the composite driver
has been installed the Found New Hardware Wizard will launch. Click "Next" to
proceed with the installation.

Found Mew Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helps vou install a device driver far 2
hardware device.

To continue, click Mest.

¢ Back I M et = | Cancel I

Select "Search for a suitable driver for my device (recommended)" as shown
below and then click "Next".
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Found New Hardware Wizard i

Install Hardware Device Drivers
& device driver iz a software program that enables a hardware device to work, with
an operating system.

Thiz wizard will complete the installation far his device:

@ USE <> Senal Cable

A device diver iz a software program that makes a hardware device work, Windows
needs diver filez for your new device. To lozate diver files and complete the
inztallation click Mest,

What do pou want the wizard o dao?
& Search for a suitable driver for my device [recommended)

™ Dizplay a lizt of the known drivers for this device zo that | can chooze a specific
driveer

¢ Back l [ et > I Cancel

Check the box next to "Specify a location" and uncheck all others as shown below.
Clicking "Next" displays a dialog box for you to enter to the location of the drivers.

Found Mew Hardware Wizard i

Locate Driver Files
Where do wou want Windows to zearch for driver files?

Search for driver filez for the fallowing hardware device:

@ USE <-> Seral Cable

The wizard searches for suitable drivers in itz driver database on your computer and in
any of the following optional zearch locatiors that vou zpecify.

To ztart the search, click Mext. If you are zearching on a floppy digk ar CD-ROM drive,
inzert the floppy dizk ar CD before clicking Mest.

Optional search locations;
™ Floppy digk drives
[~ CO-ROM drives
¥ Specify a location
[ Microsoft Windows Update

< Back l f et I Cancel
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Found New Hardware Wizard 3 x|
Inzert the manufacturer's installation dizk into the drive 0k |
g zelected, and then click OF.

Cancel |

Copy manufacturer's files from:

|C:ACOM 20000 >| | Browse.. |

Click "Browse" to display an open file dialog box.

Look in: | {3 COM 2.00.00 x| & Bk E-

Hiztary

r

File name: |FTDIBL|S.INF j Open I
;I Cancel |

Files af type: I Setup Information [*.int]

Locate the folder containing the latest drivers downloaded from the FTDI web site
above and click "Open", then click "OK". The PC auto selects the correct INF file, in
this case FTDIBUS.INF.

Once Windows has found the required driver .INF file, click "Next" to proceed.
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Found Mew Hardware Wizard

Dniver Files Search Results
The wizard haz finished sz2arching for driver files for pour hardware device,

The wizard found a driver for the fallowing device:

@ USE <-> Seral Cable

“Windowsz found a drseer For this device. To nstall the diver windows found, chek Mest.

% o hedm 200 00 tdibus. inf

< Back I f et I Cancel

Windows should then display a message indicating that the installation was successful.
Click "Finish" to complete the installation for the serial converter driver for this port of
the device. The COM port emulation driver must be installed after this has completed.
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Found New Hardware Wizard

Completing the Found New
% Hardware Wizard

_\> I15SB Senal Corwverter

Windaws has finizhed instaling the saftware Far this device.

To close this wizard, click Finish,

¢ Bach I Finigh I [Eance|

By examining the Device Manager (located in "Control Panel\System" then select the
"Hardware" tab and click "Device Manger...") and viewing by connection ("View >
Devices by connection"), the device appears as a "USB Serial Converter" with an
additional COM port with the label "USB Serial Port".
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SoeviceManager el

Jﬂctiun Wi ||1--h| |@|J

--@ Intel{R) 32801EE LPC Interface Controller - 2400
= Intel(R) 82801E6 PCI Bridge - 244E
i B Inkel(R) PROJ100 YE Metwark Connecion

Q Intel{R) 82801EE SMBus Controller - 240z

% Intel{R) 2301E6 Ultra ATA Storage Controllers

--% Intel{R) 82801EE Ultra ATA Storage Controllers

-2 IntelfR) S2801EE USE Universal Host Contraller - 2402
-- Intel{R) 82801EE USE Universal Host Controller - 2404

=- = Intel{R) 32801EE USE Universal Host Controller - 2407

E@ UsE Serial Converter
i “_ji USE Setial Park (ZOM3)

s O=L Controller - 240E
i Intel{R) 52565G\PEIP Processar to IfO Centroller - 2570
3 Realtek AC'97 Audio
H Q System board
= Audio Codecs
- Legacy fudio Drivers
- Legacy Yideno Capture Devices
M) | ogical Dsk Manager
% Media Control Devices

L] i

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.

you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for
4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download
the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

When uninstalling devices from Windows 2000, it should always be done through the
Add/Remove Programs utility as this uses the FTDI driver uninstaller program to remove
files and registry entries to leave a clean system. Other methods may leave fragments of
the driver that may interfere with future installations.

Disconnect any devices that are attached to the PC.
Open the Add/Remove Programs utility located in "Control PaneNAdd/Remove

Programs ".Select "FTDI USB Serial Converter Drivers" from the list of installed
programs.

=10l x|
]

Sark I:u';.-':l Parne ;‘

fi§l FTDI USB Serial Converter Drivers

Click. here For support information,

To change : note ik From your
computer, click Change it - Habefh e

Click the "Change/Remove" button. This will run the FTDI uninstaller program. Click
"Continue" to run the uninstaller or "Cancel" to exit.

FTDI Uninstaller x|

If your USB device is connected, please unplug it now ...

Press Continue to uninstall the drivers, or Cancel to quit.

When the uninstaller has finished removing the device from the system, the caption on
the "Cancel" button will change to "Finish". Click "Finish" to complete the process.
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FTDI Uninstaller
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Troubleshooting
1. Windows 2000 cannot find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not
match those listed in the INF files for the driver. The VID and PID programmed into

the device EEPROM may be found by using the USBView utility from the FTDI web site.
These can then be checked against the VID and PID entries in the driver INF files. If
they do not match, that driver cannot be installed for that device without either
re-programming the device EEPROM or modifying the list of VID and PID numbers in
the INF files. Please note that only your own company VID and PID or FTDI's VID
(0x0403) and FTDI PID issued for use by your company should be used in the EEPROM
and INF/INI files.

2. Windows 2000 forces a reboot after installing a device

This problem can occur if an application is accessing a file while the New Hardware
Wizard is trying to copy it. This usually occurs with the FTD2XX.DLL file. Selecting
not to restart the computer then unplugging and re-plugging the device may allow the
device to function properly without restarting. Restarting the machine will allow the
device to work correctly.

3. Driver installation fails and Windows 2000 gives error code 10

Windows error code 10 indicates a hardware error or failed driver installation. This
error may appear if a device has insufficient power to operate correctly (e.g. plugged
into a bus powered hub with other devices), or may indicate a more serious hardware
problem. Also, it may be indicative of USB root hub drivers being incorrectly installed.
Please refer to the example schematics on the FTDI web site for standard device
configurations.

4. The device hangs randomly during operation under Windows 2000

This is not caused by the driver, but is a hardware compatibility problem. Some newer
USB 2.0 hubs and host controllers can be susceptible to noise and can cause random
device failures. This can be overcome by fitting 47pF capacitors to ground on the
USBDP and USBDM lines on the USB connector side of the 27W series resistors.
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Windows CE Installation Guide

Download the latest available drivers for the required processor model from the
FTDI website and unzip them, the critical files in the driver package are:

ftdi_ser.dll - the VCP driver file

FTDIPORT.inf - user changeabile file to allow devices with custom VID and PID
combinations to be installed

Copy all of the unzipped files to the W\Windows directory on the PDA.
If the PDA requires a host adaptor (e.g. USB host cable, presentation pack or

Compact Flash host card), make sure that it is connected and installed before
proceeding.

Connect the FTDI device to a host USB port on the PDA. This will provide a dialog box
to direct Windows CE to the driver files.

Type the full name of the VCP driver file into the dialog box as shown below. If the file
name is incorrect, the driver will not be found and the device will not function.

Unidentified USB D «F «{x 12:04

(¥ sunday, June 01, 2003

Unidentified USB Device
| Enter the name of the device
driver for this device. For

information, see the device
manufacturer's docurmentation,

| DK | | Cancel |

123/1/2[3[4|5[6[7]|8]9]0]-]|=
Tablq|wle[r|t[y|u]i]o|p]|l
CAP[a[s[d[f[a[n]i[k[I]:]"
Shift[ 2 [ [c[v[b[n[m[, ].]
Ctijai| * |\ ] BE

The device installation is now complete. The installation may be verified using the test
program available form the Utilities page of the FTDI website.
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Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.
you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for

4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download

the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Troubleshooting

1. "Unidentified USB Device" dialog is not displayed when device is
connected for the first time

If the "Unidentified USB Device" dialog is not displayed when the device is connected
for the first time, it is likely that the PDA does not have a USB host capability or that
the host is not installed correctly.

Many PDAs require some form of adaptor (USB host cable, presentation pack or

Compact Flash USB host card) to provide the USB host capability that FTDI devices
require.

2. "Errorinstalling USB driver ftdi_d2xx.dll" message

The following installation error may be displayed for a number of reasons:

£ | unidentified USB D & % 10:36

(4 sunday, June 01, 2003
F=] Tap here toset owner information

=] Noupcoming appointments

‘ﬁ Unidentified USB Device

=
| Eror installing USE driver

New Tools Accounts E % E|‘

The driver name has been misspelt - The ".dllI" file extension may be required for some
platforms - The required driver files are not in the \Windows directory - The driver file is
in the wrong binary format
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3. "Error installing USB driver ftdi_ser.dll" message

The following installation error may be displayed for a number of reasons:

¥ |unidentified USB D &F x 12:17

(¥ sunday, June 01, 2003
E| Tap here to sek owner infarmation

=) MNoupcoming appaintments

Y Error installing USE driver
frdi_ser.dl

New Tools Accounts .ﬂ % E|“

The driver name has been miss pelt - The ".dll" file extension may be required for some

platforms - The required driver files are not in the \Windows directory - The driver file is
in the wrong binary format

4. "Unidentified USB Device" appears each time the driver name is entered

This error can be caused when the VID and PID listed in the INF file does not match the
VID and PID combination programmed into the device. It can also be caused if the INF
file has not been copied to the W\Windows directory.
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(¥ sunday, June 01, 2003 (® sunday, June 01, 2003

: o driver for this device, For
information, see the device
manufacturer's documentation,

" driver for this device. For
information, see the device
manufacturer's documentation,

lctlaa " [\ Lt []=

One way to check this is to use the Registry editor that comes with Embedded Visual C++
(or a suitable registry editor on the Windows CE device itself) to check for the registry
settings (Tools > Remote Registry Editor). With ActiveSync running, connect to your device
then look at the registry setting KEY_LOCAL_MACHINE\Drivers\USB\LoadClients\
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5"' Windows CE Remote Registry Editor = E ﬂlﬂ

Bagstry B Mew Cornedtion Help

R EEEREEED

% 2 My Computer = | | e
=5 POCKET P 2003 Dy [ [ p——
e (20 HEEY_CLASSES RS0
%1 |_J HKEY_CURRENT LISER
=+ HREY_LOCAL_MACHINE
# (1] Comm
& ] ControPare
=1 iz
il -
=] Eultln
#11] Displary

a] ] PCMCIA
[ R =]
[# || sDzasn
3 1] Toshiog
[ Urdmcdam
=1 I UsE
-] Chnlliepeers
[ FID0_DEVICE 0o
EL] LnagChents

[ Defaut
R B |
#- D=fmk
& ] Fepien
¥ ExiModene
#-{Z0] HARDHWARE

] et

{7] mit

=] Loader

] WUt
* s

1] Matfoem
w7 el
] Secusky
F ] Seirvices
-] %rd
T[] SOFTWARE
+ __I Sribam
w1 1am

[POCKET P 2000 Device{HEY_LOCAL_HACHIN D eersYJS81LcadBerks| LOZT_4552] [ e &

In this case, the entry is 1027 24592, which corresponds to a VID of 0x0403 (1027)
and a PID of 0x6010 (24592) device. If this is not the device to be installed, the
message will recur.

To solve the problem, the INF files must be edited to accommodate the required VID and
PID. For the D2XX drivers, edit the bold red entries in the following line in the ftd2xx.inf
file:

[FtdiHw]
"ETDI Dual device"=FTDI,USB\&VID_0403&PID_6010

For the VCP drivers, edit the bold red entries in the following line in the
FTDIPORT.inf:

[FtdiHw]
%VID_0403&PID_6010.DeviceDesc%=FtdiPort232,FTDIBUS\COMPORT&VID_0403&PI
D_6010

5. Device can write but cannot read

30-60




If the hardware does not work correctly under Windows 2000 or Windows XP then the
problem is most likely a hardware issue. Windows CE is not very tolerant of noisy
hardware, so even "good" designs for Windows 2000 and XP may experience problems
with Windows CE.

Another issue that has arisen with Windows CE is that different host devices support
different bulk transfer sizes. One method to attempt to resolve this is to reduce In
Transfer Size to 64. This is the smallest possible transfer size and will have a severe
effect on performance, but should resolve most other issues. Larger values may be tried
to improve performance.

If a USB host CF card is being used, it may help to set the Raton bit in the configuration
settings.

6. Bytes missing or data corrupt

This can occur when a host driver fails to send vendor commands properly which can
result in the device running at a different Baud rate to the one intended. The Baud rate
can be verified easily by transferring data from PDA/target to HyperTerminal.

Some host device drivers have been seen to lose packets of data which would also
cause this problem.

7. Driver isn't sending or receiving any data
Sending and receiving data can be tested with an application such as VCPTest.
However, this will not highlight problems due to incorrect Baud rates. To check for

the wrong Baud rate being set, try to transfer data from the PDA/target to and from
HyperTerminal.
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Windows XP Installation Guide

1. Installing Via The Found New Hardware Wizard

If a device of the same type has been installed on your machine before and the drivers
that are about to be installed are different from those installed already, the original
drivers need to be uninstalled. Please refer to the Uninstalling instruction.

Download the latest available drivers from the FTDI web site and unzip them to a
location on your PC.

If you are running Windows XP or Windows XP SP 1, temporarily disconnect your PC
from the Internet. This can be done by either removing the network cable from your PC
or by disabling your network card by going to the "Control Pane\Network and Dial Up
Connections", right clicking on the appropriate connection and selecting "Disable" from
the menu. The connection can be re enabled after the installation is complete. This is not
necessary under Windows XP SP 2 if configured to ask before connecting to Windows
Update. Windows XP SP 2 can have the settings for Windows Update changed through
"Control Panel\System" then select the "Hardware" tab and click "Windows Update".

Connect the device to a spare USB port on your PC. If the device is based on the
FT2232, the Microsoft composite device driver is automatically loaded in the background.
Once the composite driver has been installed Windows Found New Hardware Wizard

will launch. If there is no available Internet connection or Windows XP SP 2 is configured
to ask before connecting to Windows Update, the screen shown in Figure 2.1 is
displayed. Select "No, not this time" from the options available and then click "Next" to
proceed with the installation. If there is an available Internet connection, Windows XP

will silently connect to the Windows Update website and install any suitable driver it finds
for the device in preference to the driver manually selected.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

‘windows will search for current and updated software by
lnaking on your computer, an the hardware installation CO. ar on
the "Windows Update ‘Web site [with vour permission)

Online privacy information

Can ‘windows connect to Windows Update to search far
software?

() Yes, this time only

(O Yes, naw and gvery time | connect a device

Click Next to continue.

Figure 2.1
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Select "Install from a list or specific location (Advanced)" as shown in Figure 2.2 below
and then click "Next".

Select "Search for the best driver in these locations" and enter the file path in the combo
box ("C:\CDM 2.02.04" in Figure 2.3 below) or browse to it by clicking the browse button.
Once the file path has been entered in the box, click next to proceed.

Found New Hardware Wizard

Thiz wizard helps vou install software for:

LISE Serial Corverter

Z"'j If your hardware came with an installation CD

\:{ﬂ o1 floppy dick. ingert it now.

‘What do you want the wizard to do?

() Install the software automaticaly (Recommended)
(®)iinstall from a list or specihic jocation [Advancedt

Click Mext to continue.

< Back H Mext > ][ Cancel

Found New Hardware Wizard
Please choose your search and installation options. .

(3) Search for the best driver in these locations.

Use the check boxes below ta limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

[ Search removable media [floppy, CO-ROM. ]

Include this location in the search:

|CACDM 2.02.04 R4

(O Don't search. | wil choose the driver to install

Chooze this option to select the device diver from a list. Windows does not guarantee that
the driver pou choose will be the best match for pour hardware.

[ ¢ Back ][ Mext = ][ Cancel

Figure 2.3

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are
about to be installed, the message dialogue shown in Figure 2.4 will be displayed unless
installing a Microsoft WHQL certified driver. Click on "Continue Anyway" to continue with
the installation. If Windows XP is configured to ignore file sighature warnings, no
message will appear.

The screen shown in Figure 2.5 will be displayed as Windows XP copies the required
driver files.
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Hardware Installation

L E The software pou are installing for this hardware:
L
USB Serial Converter

has not passed Windows Logo testing ta verify its compatibility with

this version of ‘Windows. [Tell me why this testing is important)

Continuing your i llation of this sofl may impair
or destabilize the correct operation of your spstem
either immediately or in the Future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ Continue Anyway ] ‘ STOP Installation |

Figure 2.4

Found New Hardware Wizard
Please wait while the wizard installs the software. .. .

Q USE Serial Converter

L= -y
frd 2. dll
To CNWwWINDOWS systena2

Figure 2.5

Windows should then display a message indicating that the installation was successful
(Figure 2.6). Click "Finish" to complete the installation for the first port of the device.

If the device is based on the FT2232, the Found New Hardware Wizard will continue by
installing the USB Serial Converter driver for the second port of the FT2232 device. The
procedure for installing the second port is identical to that for installing the first port from
the first screen of the Found New Hardware Wizard. This is done automatically if the
driver is Microsoft WHQL certified. If the device is not based on the FT2232, the COM
port emulation driver is loaded as indicated in the following steps.

The Found New Hardware Wizard will launch automatically to install the COM port

emulation drivers. As above, select "No, not this time" From the options and click "Next"
to proceed with the installation (Figure 2.7).
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

g UISB Serial Converter

Click. Finizh to close the wizard,

Figure 2.6

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windows will search for current and updated software by

looking on your computer, on the hardware installation CO, ar on
the 'windows Update 'Web site [with your permission).

Orling privacy information

Can Windows connect ta \wWindaws Update to search far
software?

(O Yes, this time anly
() Yes, now and every time | connect a device

@

Click Mext to continue.

Mewt > Cancel

Figure 2.7

Select "Install from a list or specific location (Advanced)" as shown in Figure 2.8 below
and then click "Next".

Select "Search for the best driver in these locations" and enter the file path in the combo

box ("C:\CDM 2.02.04" in figure 2.9 below) or browse to it by clicking the browse button.
Once the file path has been entered in the box, click next to proceed.
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Found New Hardware Wizard

Thiz wizard helps pou install software for:

USE Serial Part

\) If your hardware came with an installation CD
&2 or floppy disk. insert it now.

‘What do you want the wizard to do?

() Install the software automaticaly (Recommended)
(®iinstall from a list or specihic jocation [Advancedt

Click Mext to continue.

[ < Back H Mext > ][ Cancel

Figure 2.8

Found New Hardware Wizard
Please choose your search and installation options. .

(& Search for the best driver in these locations:

Use the check boxes below ta limit or expand the default search, which includes local
paths and remaovable media. The best driver found will be installed.

[ 5earch removable media [floppy, CD-ROM...]

Include this location in the search:

[EACOM 20204 v

() Don't search, | wil choose the driver to install

Choose thiz option to select the device diver from a list. Windows does not guarantee that
the driver vou choosze will be the best match for your hardware.

[ < Back H Mext > ][ Cancel

Figure 2.9

If Windows XP is configured to warn when unsigned (non WHQL certified) drivers are
about to be installed, the message dialogue shown in Figure 2.10 will be displayed
unless installing a Microsoft WHQL certified driver. Click on "Continue Anyway" to
continue with the installation. If Windows XP is configured to ignore file signature

warnings, no message will appear.

The screen shown in Figure 2.11 will be displayed as Windows XP copies the required
driver files.
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Hardware Installation

L E The software pou are installing for this hardware:
L
USB Serial Part

has not passed Windows Logo testing ta verify its compatibility with

this version of ‘Windows. [Tell me why this testing is important)

Continuing your i llation of this sofl may impair
or destabilize the correct operation of your spstem
either immediately or in the Future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

[ Continue Anyway ] ‘ STOP Installation |

Figure 2.10

Found New Hardware Wizard
Please wait while the wizard installs the software. .. .

3 USE Serial Port
i

) T B

frsemi2 dil

To CAWINDOWS \spstern32

[ )|
Figure 2.11

Windows should then display a message indicating that the installation was successful
(Figure 2.12). Click "Finish" to complete the installation for the first port of the device.

If the device is based on the FT2232, the second port must also be installed. The
procedure for installing the second port is identical to that for installing the first port from
the first screen of the Found New Hardware Wizard for the USB Serial Port device. If the
driver is Microsoft WHQL certified, this is done automatically.

Open the Device Manager (located in "Control Panel\System" then select the
"Hardware" tab and click "Device Manger") and select "View > Devices by Connection”,
the device appears as a "USB Serial Converter" with an additional COM port with the
label "USB Serial Port" (Figure 2.13). If the device is based on the FT2232, two ports will
be available from a composite USB device.
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Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished installing the software for:

/g UISB Serial Port

Click. Finizh to close the wizard,

Figure 2.12

Device Manager

File  Action Wew Help

== A
'd ACPI Fixed Feature Butkon ~
8 Genuine Intel(R) CPU 2160 @ 1.80GHz
% Genuine Intel(R) CPU 2160 @ 1.80GHz
-l id PClbus

I+ é InkelR) 94652 Express Chipset Family
[+ ' Inkel(R) 52501 PCI Bridge - 244E
Intelif) §2801G (ICHT Family) SMBus Controller - 2704
" Intel{R) 828016 (ICH7 Family) USE Universal Host Contraller - 2703
Inkel{R) 828016 {ICH7 Family) USE Universal Host Controller - 27C9

5B Setial Converter
5 UsE Serial Port (CoM3)

+ Inkel(E = FIOSE Universal Host Controller - 27CA
[+ Inkel{R) 825016 {ICHT Family) USE Universal Host Controller - 27CE
e Intel{R) §2801G {ICH7 Family) USEZ Enhanced Host Contraller - 27CC
[#- 1 Intel{R) 52801GE{GR. (ICH7 Family) LPC Interface Controller - 2765
[#-{Z) Intel(R) 62601 GBIGRGH (ICH7 Famiy) Serial ATA Storage Controller - 27C0

j Inkel{R) 946GZJPLIGL PCI Express Rook Port - 2971

j Inkel{R) 946GZIPLIGL Processor ko 1iO Contraoller - 2970
+ j Microsoft UAA Bus Driver For High Definition Audia

j Motherboard resources v

Figure 2.13

In the case of the FT2232, port A of the FT2232 will be installed as COMX and port
B will be installed as COMX+1 where COMX is the first available COM port number.
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5. Device Manager

Eile  Action Wew Help

M & 2060 A&

|- iJ PCIbus A
[+ :-2 Intelift) 94662 Express Chipset Family
[#- i Intel(R) 62801 PCI Bridge - 244E
Inkel{R) $2801G {ICHT Family) SMBus Contraller - 2704
+ Inkel{R) 828016 (ICH7 Family) USE Universal Host Controller - 27C8

+ InkelR) 828016 {ICH7 Family) USE Universal Host Controller - 27C9
= Inkel{R) 25016 {ICHT Family) USE Universal Host Controller - 27CA
&2 USE Roob bk
B U3E Composite Device
= % USE Serial Converter &
5 USB Serisl Port (COM3)
= GED USE Serial Converter B
5 UsB serial Port (COM4)
+ InkelFT Tzames & e Tniversal Host Controller - 2708
1+ Inkel{R) 25016 {ICHT Family) USB2 Enhanced Host Contraller - 27CC
1+ j InkelR) 82501 GB/GR (ICHT Family) LPC Intetface Controller - 2788
143 InteliR) 82301 GBJGRGH (ICHT Family) Serial ATA Storage Controller - 27C0
_J Intelift) 946G2(PL/GL PCI Express Root Port: - 2971
} Intelift) 946G2(PL)GL Processor o 10 Controller - 2970
[+ } Micrasoft L&A Bus Driver For High Definition Audio
_& Motherboard resources v

Figure 2.14

2. Installing Using DPInst

In the case of a Microsoft WHQL certified driver package, it is possible to preinstall the
driver package using the Microsoft Driver Install Frameworks (DIFX) tools. The simplest
tool provided is the Driver Package Installer (DPInst). When placed in the same directory
as the INF files for the driver package, simply run DPInst.exe and the certified driver
package will be installed on the machine.

The current driver package supports 32bit and 64bit systems through common INF files.
DPInst has separate executables for 32bit and 64bit installation. This means that if a
single solution is desired for 32bit and 64bit systems, the developer must be able to
detect which version of DPInst is required for the system the driver is being installed on.

For more information on DPInst, see the FTDI Windows Driver Installation application
note.

3. Installing From Windows Update

If a certified driver is available for the target operating system, it is possible to install
the driver from the Windows Update web site.

Directions to install the driver from Windows Update are very similar to those outlined in
2.1 Installing Via The New Hardware Wizard, except that the “Yes, this time only” or
“Yes, now and every time | connect a device” option should be selected on the first
screen of the wizard when asked if Windows Update should be checked for a driver. If
the wizard finds a matching driver on Windows Update, the driver will be automatically
downloaded and installed for the device.
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Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.
you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for
4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download
the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

Consequently, a new method for uninstalling has to be used. Devices can be removed
using the Device Manager by simply right clicking on the device and selecting "Uninstall".
This will delete the associated registry entries for that device only.

Under Windows XP, driver files and OEM INF and PNF files must be removed manually
or by using a custom application. OEM INF and PNF files are located in the Windows\Inf
directory and can be identified by searching for a VID and PID string matching the
device installed e.g. VID_0403&PID_6001. Once the matching OEM INF files are found
(e.g. 0em10.inf for FTDIBUS.INF and oem11.inf for FTDIPORT.INF), the corresponding
PNF files must also be removed (e.g. oem10.pnf and oem11.pnf). Driver files are located
in the Windows\System32 and Windows\System32\Drivers directories.

Some points to note about this uninstallation method:

In the case of FT2232 devices, a composite device is also installed. This can also be
removed by right clicking on the composite device in the Device Manager and selecting
"Uninstall".

If the VCP driver has been installed, the COM port driver should be removed before the
bus driver. If the bus is removed first, the COM port will no longer appear in the Device
Manager.

If the driver files are deleted while other installed devices still require them those devices
will not work correctly. This can be fixed by right clicking the device and selecting
"Reinstall Driver" which will replace the missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed
by setting the device manager to show phantom devices. This can also allow a virtual

COM port to be uninstalled if the bus layer has been removed first. Instructions on how
to display phantom devices are given in the Advanced Driver Options application note.
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Troubleshooting

1. Windows XP cannot find Drivers for My Device

This error can occur if the VID and PID programmed into the device EEPROM do not
match those listed in the INF files for the driver. The VID and PID programmed into the
device EEPROM may be found by using the USB View utility from the FTDI web site.
These can then be checked against the VID and PID entries in the driver INF files. If they
do not match, that driver cannot be installed for that device without either reprogramming
the device EEPROM or modifying the list of VID and PID numbers in the INF files.

Please note that only your own company VID and PID or FTDI's VID (0x0403) and FTDI
PID issued for use by your company should be used in the EEPROM and INF/INI files.

End customers should obtain modified drivers from the OEM of the device, and not
necessarily edit the files themselves.

2. Windows XP Forces a Reboot after Installing a Device

This problem can occur if an application is accessing a file while the New Hardware
Wizard is trying to copy it. This usually occurs with the FTD2XX.DLL file. Selecting not to
restart the computer then unplugging and re-plug the device may allow the device to
function properly without restarting. Restarting the machine will allow the device to work
correctly.

3. Driver Installation Fails and Windows XP Gives Error Code 10

Windows error code 10 indicates a hardware error or failed driver installation. This error
may appear if a device has insufficient power to operate correctly (e.g. plugged into a
bus powered hub with other devices), or may indicate a more serious hardware problem.
Also, it may be indicative of USB root hub drivers being incorrectly installed.

Please refer to the example schematics on the FTDI web site for standard device
configurations. If the error persists, please contact the FTDI support department.

4.4 Windows XP Displays An Error And Then Terminates Installation

If the following screen is displayed with this message, Windows XP has been
configured to block the installation of any drivers that are not WHQL certified.
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Hardware Installation

@ The software vou are installing for this hardware:
USB Seral Converter

has not passed Windows Logo testing to verife itz compatibiliby
wath this version of Windows, [Tell me wiw this teshing iz important)

Thiz hardware will not be installed. Contact pour system
administrator.

Figure 4.1

Two options are available to successfully install the device. Either a certified version of
the driver can be installed (if available) or the driver signing options can be changed to
either warn or ignore to allow the installation to complete.

To change the current driver signing setting, go to "Control Panel\System", click on the
"Hardware" tab and then click "Driver Signing". The desired signing option may then be
selected.
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Windows VISTA(Win 7, Win 8) Installation Guide

Connect the device to a spare USB port on your PC.

If there is an available Internet connection, Windows VISTA (Win 7, Win 8)will silently
connect to the Windows Update website and install any suitable driver it finds for the
device in preference to the driver manually selected. If no suitable driver is automatically
found then the following procedure should be followed.

. Found New Hardware ==

Windows needs to install driver software for your TTL232R
Tester

¥ Locate and install driver software (recommended)
Windows will guide you through the process of installing driver software
for your device,

% Ask me again later
Windows will ask again the next time you plug in your device or log on.

¥ Don't show this message again for this device
Your device will not function until you install driver software.

When locate and install driver software (recommended)” is selected the following screen
will appear. Note: the text “TTL Tester” is replaced with the description of the customer
hardware.
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@ i|1|_ Found Mew Hardware - ﬁLBER Tester

Insert the disc that came with your TTL232R Tester

If you have the disc that came with your device, insert it now. Windows will automatically
search the disc for driver software.

< Idon’t have the disc. Show me other options.

Select “| don't have the disk. Show me other options” The next screen will appear.
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Windows couldn't find driver software for your device

% Check for a solution
Windows will check to see if there are steps you can take to get your device
working.

< Browse my computer for driver software (advanced)
Locate and install driver software manually.

Select “Browse my computer for driver software (advanced)”. The next screen will
appear.

Search for driver software in this location:
§C: User I

[¥] Include subfolders
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Browse to the folder where the CDM driver has been stored (when uncompressed) and
press “Next”

The example shown above uses a folder on the desktop.

The next screen will appear.

\Z) [l Found New Hardware - TTL232R Tester

Installing driver software...

This screen will automatically complete and then change to the one below:
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ey O Found Mew Hardware - USE Serial Converter

The software for this device has been successfully installed
Windows has finished installing the driver software for this device:

USB Senial Converter

Cloze

The bus layer of the driver is now installed.

After the driver is installed it is important to determine which COM port has been
assigned to the device for configuring the application that will use the device.

Open the Device Manager (located in "Control Panel\System" then select the
"Hardware" tab and click "Device Manager") and select "View > Devices by
Connection", the device appears as a" USB Serial Converter" with an additional COM
port with the label "USB Serial Port".
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4 Device Manager [F=3 ol ~>

File Action View Help
e T HFE &

#1-4& Computer

[#¢—y Disk drives
#- B Display adapters
ety DVD/CD-ROM drives
4 Floppy disk drives
1= Floppy drive controllers
] &_.'-", Human Interface Devices
g IDE ATA/ATAPI controllers
@ @ IEEE1394 Bus host controllers
== Keyboards
ﬂ Mice and other pointing devices
- B Monitors
' & Network adapters
KD Portable Devices
T Ports (COM & LPT)
"? Communications Port (COM1)
T2 Printer Port (LPT1)
'? USB Serial Port (COM3)
j B Processors
|-% Sound, video and game controllers
: &, High Definition Audio Device
1-4; Storage controllers
#-4&l System devices
|- @ Universal Serial Bus controllers

[+

0 N

iz}

i

®

|

A T - .

&

This screen shows the device connected to COMS3.

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.
you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for
4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download
the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling Instruction

With the release of Microsoft Windows Vista, the FTDI uninstaller has been rendered
unusable due to Windows Resource Protection preventing the executable from deleting
driver files and associated registry values. Vista will only allow the system itself to modify
files and registry values in these locations.

Consequently, a new method for uninstalling is required. Devices can be
removed using the Device Manager by simply right clicking on the mouse and
selecting "Uninstall". This will delete the associated registry entries for that
device only. Vista provides an automatic method to delete driver files via a check
box to "Delete the driver software for this device" on the uninstall dialog box.

- Confirm Device Uninstall

USE Senal Converter
L

Waming: You are about to uninstall this device from your system.

| ok || Cancel

Windows 2000, XP and Server 2003 do not have this check box, so driver files
and OEM INF and PNF files must be removed manually or by using a custom
application.

Some points to note about the new uninstallation method:

In the case of FT2232 devices, a composite device is also installed. This can also be
removed by right clicking and selecting "Uninstall'. There is no option to delete the driver
files when doing this as the driver for the composite device is a native Windows driver.

If the VCP driver has been installed, the COM port driver should be uninstalled before
the bus driver. If the bus is removed first, the COM port will no longer appear in the
Device Manager.

If the files are deleted while other installed devices still require them those devices will
not work correctly. This can be fixed by right clicking the device and selecting "Reinstall
Driver" which will replace the missing files.

If a device to be uninstalled is not connected to the PC, the device can still be removed

by setting the device manager to show phantom devices. This also allows a virtual COM
port to be uninstalled if the bus layer has been removed first.
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Troubleshooting

1. Windows VISTA(Win 7, Win 8) can not find drivers for my device

This error can occur if the VID and PID programmed into the device EEPROM do not
match those listed in the INF files for the driver. The VID and PID programmed into the
device EEPROM may be found by using the USB View utility from the FTDI web site.
These can then be checked against the VID and PID entries in the driver INF files. If
they do not match, that driver cannot be installed for that device without either re-
programming the device EEPROM or modifying the list of VID and PID numbers in the
INF files. Please note that only your own company VID and PID or FTDI's VID (0x0403)
and FTDI PID issued for use by the customer should be used in the EEPROM and INF
files.

End customers should obtain modified drivers from the OEM of the device, and not
necessarily edit the files themselves.

2. Devices not shown in Device Manager for uninstalling

Devices that have been installed on a system but are not currently available are referred
to as "phantom devices". These devices are not usually displayed in the device manager,
but can be made to be displayed as though they are attached. This allows device
properties to be changed or devices to be uninstalled via Device Manger even though
the device is not physically connected to the PC.

To display phantom devices in Device Manager, a new system variable is required.
Open "Control Panel > System" then select the "Advanced" tab and click
"Environment Variables". In the System Variables section (NOT THE USER
VARIABLES SECTION), click "New..." to display the following window:

Edit System Variable [
Variable name: DevMar_Show_MonPresent_Devices
Variable value: 1]
[ Ok | | Cancel |

Create a new System Variable called "DevMgr_Show_NonPresent_Devices" and
set the value to 1, then click OK.

Open the Device Manager ("Control Panel > System" then select the "Hardware"
tab and click "Device Manager...", or "Control Panel > Device Manger" in Vista)
and select "View > Show Hidden Devices". Device Manager will then show all
hidden and phantom devices available on that PC as shaded.
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3. Windows Vista(Win 7, Win 8) shows a warning that the driver is not
certified

If the driver is not certified then a pop up window such as shown below will be displayed.

'[3} Windows Security ]

@ Windows can’t verify the publisher of this driver software

<» Don't install this driver software
ou should check wour manufackurer's website for updated driver software For your
device,

=% Install this driver software anyway
Only install driver software obtained from your manufacturer's website or disc,
Unsigned software From atber sources may harm your computer o steal infarmation.

Ll See details

If you are certain of the source of the driver the warning can be ignored and you
can continue installation by selecting “Install this driver software anyway”.

4. Driver will not install on VISTA x64

VISTA x64 OS will only allow certified drivers to be installed. The certified driver supplied
by FTDI will work with VID 0403 and PID 6001 for FT232 and FT245 devices. It will also
work with VID 0403 and PID 6010 for FT2232 devices.

If you have a product where the manufacture has customized the driver but has not re-

certified it, then the driver will not load. You should contact your vendor to determine if
they will support VISTA x64.
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MAC OS X Installation Guide

Download the driver from the VCP Drivers section of the FTDI web site and save it to the
hard disk. The driver is now available in disk image (.dmg) format. Run the installer by
double clicking on the FTDIUSBSerialDriver.dmg icon.

rB an Install FTDIUSBSerialDriver Kernel Extension

Welcome to the FTDIUSBSerialDriver Kernel Extension Installer

i“ — Welcome to the Mac OS5 X Installation Program. You will be
& Introduction guided through the steps necessary to install this software.

® Relid Me
® Select Destination
@ Instaliation Type

@ Installing

® Finish Up /

Gom

Click Continue to proceed with the installation and follow the instructions on screen.

When the installation is complete, reboot the computer.
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rB an Install FTDIUSBSerialDriver Kernel Extension

Install Software

=

© Introduction
© Read Me
2 Select Destination

© Installation Type
© Installing The software was successfully installed

 Finish Up /

Click Restart to finish installing the software.

_

When the computer has rebooted, plug in the device. If the device is installed
properly, you will see entries in the /dev directory:

/dev/cu.usbserial-XxxXxxxxx
/dev/tty.usbserial-XXXXXXXx

Where xxxxxxxXx is either the device's serial number or, for unserialized devices, a
location string that depends on which USB port your device is connected to. The
Terminal application can be launched by selecting Go > Applications > Utilities >
Terminal. Type the following lines in the Terminal window to produce the file list:

cd /dev
Is-1

If you run the application System Preferences and select Network (Go > Applications
> System Preferences > Network), you should see the text "New Port Detected".
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New Port Detected
ﬂ ﬁ A new network port has been detected:

ushserial-1B22

Please verify that it is configured correctly, then

press Apply Mow to activate it

Click OK and select Network Port Configurations from the show list. The new port can be
enabled from this screen by checking the on box and clicking Apply Now.

r B
8eeon MNetwork (5]
; — '
« = aHO
: O V" — !
Show All ¢ Displays Sound MNetwork Startup Disk
¢ f v 3
Location: Automatic I—H

Show: : Metwork Port Configurations I-ﬁ-]

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On  Port Configurations
B usbserial-1B22
E Internal Modem
E Built-in Ethernet

Delete. ..

Duplicate

@

2
Iﬂt Click the lock to prevent further changes. (Assist me... ) [ Apply Now :)

At this point, it is possible to exit Network and use the device as a COM port. If you
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wish to set the device up a modem for an Internet connection, select the new port from

the Show list to display the window below.
FB 80 Metwork :‘_::;1'|
<« W HO [

Show all Displays Sound | Metwork Startup Disk

ik

g L S

Location: | Automatic

ik

Show: usbserial-1822

[ PPP | TCP/IP  Froxies Modem

Service Provider: (Optional)
Account Mama:
Password:
Telephone Number:
(Optianal)

Alternate Number:

"] Save password
Checking tnis box allows all users of this computer to
access this Internet account without entering a password.

(PPP Options... j) C Dial Now... \,'l

@

i PE—
4_351' Click the lock to prevent further changes. [ Assist me... | Apply Now

Entries for this screen are specific to the Internet account for each user. If you do not
know the required details, contact your Internet service provide

Please note:

1. For multiple-port converter, each port has to be installed with the driver individually, i.e.
you have to repeat this installation procedure 2 times (2-port converter) or 4 times (for

4-port converter).

2. If you have any difficulties with the drivers we provided in this CD, you may download

the updated or appropriate versions from FTDI Web site
www.ftdichip.com/Drivers/VCP.htm, supported device “FT232BL(M)".
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Uninstalling instruction

To remove the drivers from Mac OS X, the user must be logged on as root. Root is a
reserved username that has the privileges required to access all files.

Start a Terminal session (Go > Applications > Utilities > Terminal) and enter the
following commands at the command prompt:

cd /System/Library/Extensions

rm -r FTDIUSBSerialDriver.kext

cd /Library/Receipts

rm -r FTDIUSBSerialDriver.kext

The driver will then be removed from the system.

To remove the port from the system, run the application System Preferences and select
Network. Selecting Network Port Configurations from the Show menu will display the
port as greyed out. Select the uninstalled port and click Delete. Confirm the deletion to
remove the port.

r e h
e o Network (=)
¢« B H O E
Show All Displays Sound | Network | Startup Disk

ar

Location: Automatic -

)
1

Show: Metwork Port Configurations |5

Check a configuration to make it active.
Drag configurations into the order you want to try them when
connecting to a network.

On Port CunFiQuratinns

ushserial-1B22

E Internal Modem ' e
™  Built-in Ethernet f Edit )
( Delete... )
Duplicate
@
=i S
{1 Click the lock to prevent further changes. [ Assistme... ) Apply Now
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Troubleshooting

1. How do | know what my device ID is?

Launch the System Profiler utility, or Apple System Profiler for earlier versions of OS X.
This can be accessed by going to the Finder and selecting Applications from the Go
menu, then open the Utilities folder.
Select USB under Hardware in the pane to the left and then select the appropriate
device from the USB Device Tree. In the screen shot below (from OS 10.3), the device
has a device ID given by:

Vendor Name: FTDI

Product ID: 24577 ($6001)

A Vendor Name of FTDI is equivalent to a Vendor ID of 1027 ($0403).

re (Gl System Praofile
Andy's eMac 10/01/2005 08:37
[ Contents | USE Device Tree
¥ Hardware USE Bus
Memaory W USB Bus
PCI/AGP Cards ¥ Hub in Apple Extended USB Keyboard
ATA USB <-> Serial
SCsI Apple Optical USB Mouse
UsSB Apple Extended USE Keyboard
FireWire USE Bus
AirPort Card USB High-5peed Eus
Modems
¥ Software
Applicatiors -
Extensions USB <-> Serial:
MNemwork
Logs ~ Vendor Name:  FTDI
Speed: Up to 12 Mb/sec
Product ID: 24577 (36001)

Bus Power (mA): 100

A

If the device does not work after installing the driver, it is likely to be because the PID is
not supported by the driver. If this is the case, contact FTDI Support with the PID that
needs to be added to the driver. If the VID is not 0x0403, it is likely that the device is not
an FTDI device and we cannot support it.
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2. The device does not appear in the /dev directory or the text "New Port
Detected" is not displayed in System Preferences-Network

FTDI USBSeria Driver does not support your device ID (VID and PID). Disable
the EEPROM so that the device reverts to its default device ID, then replug. To
get support for your device ID built into FTDI USBSerial Driver, contact FTDI
quoting your device ID and a description of your device.

3. The device cannot be accessed even though the device ID is Supported
in FTDI USBSerial Driver

An ownership or permissions problem is preventing the system from making the
device accessible. Check that the driver is owned by root and wheel. The most
common symptom is the group for FTDI USBSerial Driver is not wheel. To
change the group, login as root and perform the following script in a Terminal
window (Go > Applications > Utilities > Terminal):

cd /system/library/extensions

chgrp -R wheel FTDIUSBSerialDriver.kext

Reboot for the change to take effect.
4. How do | open a Terminal window?

A Terminal window can be started by selecting Go > Applications > Utilities >
Terminal .The terminal window is equivalent to a DOS prompt in Windows.
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Regulatory Compliance

FCC

This equipment has been tested and found to comply with the FCC Rules.
Operation is subject to the following two conditions:

(1) This device may not cause harmful interference
(2) This device must accept any interference received, including interference that
may cause undesired operation.

CE

This equipment is in compliance with the requirements of the following regulations:
EN 55022: CLASS B

ROHS

All contents of this package, including products, packing materials and documentation

comply with RoHS.

X ros FE CE
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